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1 7 Agilent VEE 44§ CD > ™ #~ "+ Install Agilent VEE Pro 9.0 ﬁ? Install
gilent VEE Express 9.0- InstallShield® Wizard %'TE_‘H? o [EEL[2 Y BRI o

Agilent VEE 9.0 Installation CD

Install Agilent VEE Pro 9.0
Install Agilent VEE Express 9.0

Install Agilent VEE Runtime 9.0
Install Microsoft .NET Framework 3.5

RS it B BT 19 F1 -

2 InstallShield® Wizard Eﬂfp | ﬂg“[%!/%& Agilent IO Libraries Suite
15.0 = Fy o 4E - PI@RE ™ SRR IR -

Agilent VEE Pro - InstallShield Wizard

Agilent IO Libraries Suite 15.0 or greater is not found,
' Agilent VEE requires Agilent IO Libraries Suite 15,0 or greater for communicating with instruments,
Please install Agilent I Libraries Suite 15.0 or greater after finishing this setup,

=B UHN & H ] Agilent VEE 2 5383574 [ Agilent 10 Libraries
uite 15.0 fLARIFHIZ o (= ﬁ%& SURyrab i i > 45t Agilent 10
Libraries Suite 15.0 f5I'| 5%
- ™ OK - InstallShield® Wizard Fﬁﬁ%@ﬂ?{“%%& Microsoft .NET
Framework 3.5

)
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( 3 Y i FEE Microsoft .NET Framework 3.5 [l[ (15557 %] Question
’ET:F R BV BT o - N Yes T H[J5 %f Microsoft .NET
Framework 3.5 54 5% 4% » Agilent VEE —L%ff 1FIEEM -3~ ™ No
%’AHILF Agilent VEE 473 -

i/[l%JL'%J/%& Microsoft .NET Framework 3.5 - InstallShield® Wizard 3
B EaEsE - WS TR 1 A SELPY Agilent VEE I o

Question

® ) Microsoft \NET Framework 3.5 must be installed before installing Agilent YEE,
\',f) Do you want to install Microsoft \MET Framework 3.5 now?

‘es ] [ Mo

=

'%*Wﬂ@%ﬂﬁ B~ ™ Next o

Agilent VEE Pro 9.0 Setup X
n
n

Welcome to the InstallShield Wizard for Agilent
YEE Pro

The InzstallShield® wizard will install Agilent VEE Fro on
your computer. To continue, click Mest.

< Back Mext > ][ Cancel

5 i License Agreement ﬂ‘—fﬁf AR gg#‘:@fﬁ'% A
ext

. J

Agilent VEE Pro 9.0 & Agilent VEE Express 9.0 5 * F'FJ;C'F”,FFJ b




Agilent VEE Pro 9.0 Setup

License Agreement -
Fleaze read the following license agreement carefully. %

The license agreements contained here are for 2 different uses of this ~
product. Please review and click to accept the appropriate license
agreement for the product you are installing, either a purchased product,

or a 30-day Evaluation usage.

Ewvaluation License

LEGAL MOTICE: PLEASE READ THESE LICENSE TERMS BEFORE
INSTALLING OR OTHERWISE USING THE LICENSED MATERIALS.
ALL USE OF THESE LICENSED MATERIALS 1S SUBJECT TO THE v

(®) | accept the terms of the license agreement

(| da not accept the terms of the license agreement

[ < Back " Mext > ] [ Cancel ]
 Customer Information a:j‘ﬁﬂ“hiﬂ e Eﬁ ﬁ?‘ [Pl £ YE] EFE A
FﬁE,\_,éﬁ » SR~ ™ Next- & Fﬁ[l,_f o w7 I;'ﬁ Agzlent VEE Pro Foig
Agilent VEE Express Product Key Certszate Hie
Agilent VEE Pro 9.0 Setup 53

Customer Information
Fleaze enter your information.
User Mame:

bilab-uzers

Company Mame:

agilent lab

Product Key [Enter EVAL for a 30-day evaluation install):
Evial
Install thiz application for:

(®) Anyone wha uzes this computer [all users)

) Only for me (bilab-users)

[ < Back " Mext > ][ Cancel

/
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Agilent VEE Pro 9.0 Setup
Choose Destination Location -
Select folder where setup will install files, 2\/

Setup will install Agilent YEE Pra in the following folder.

Ta install to this folder, click Mext. To install to a different folder, click Browse and select
another folder.

Destination Folder

C:\Program FilesAgilent'VEE Fro 9.0

< Back " Mext > ][ Cancel ]

8 }Jl[ Setup Type ‘é*éffﬁ::ﬁﬂiﬂ%ﬁ% E\J]: » 3V Typical Setup » R4~ ™ Next
Kb -

Agilent VEE Pro 9.0 Setup

Setup Type
Select the zetup type to install 2\/

Click the type of setup vou prefer, then click Mext.

() Typical Program will be installed with the most common options. Recommended for
most uzers.

(O Compact  Pragram will be installed with minimum required aptions.

() Custom “You may zelect the options you want to install. Recommended for advanced
users.

< Back " Mext > ][ Cancel
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7?9[‘;‘1*1 Agilent VEE Pro 75 Agilent VEE Express

2= E[’?‘Eﬁ&!?‘? (All Programs) > Agilent VEE Pro 9.0 > VEE Pro 9.0 F‘}El’?‘éjiﬂfc
(All Programs) > Agilent VEE Express 9.0 > VEE Express 9.0 » ?SI‘E*J Agilent VEE Pro
F‘} Agilent VEE Express °

File Edit Wiew Debug Flow Device System DO Data Display Tools Database Excel ‘Window Help
NEEHS $ @92k 1 a3 78 M&f. @A BB L Bl S 5o @ESE

— ETf
= Program Explorer
5 Unlitled

¢ ED

1a5ta0g PaIfG 7 LoRIUN A | JabEUEl) usunsU]

. Agilent VEE Pro Agilent Technologies
Introduction Tlp of the Day

What's New ‘YU can view a VEE Object's menu by clicking
on the upper-left hand camer of the ohject or
Web Demos by right-clicking anywhere over the object

oatance
oafef G- -E-Pﬂinr —
Fg-iﬁ—- Ej 1 onvert Infirity ! False MATLAB Examples

El Design Example Programs

B Popup Panel

¥ Bhow this sereen at startup

Tite

ﬁ'{.[ l’}ﬁ] FL-[' Tile sting of the object
*El Output
g — =

ExecMode: YEES

[&F Il Agilent VEE Pro f% Agilent VEE Express Bl v 2V
=i #% - MATLAB #5fj] ( [ {7 Agilent VEE Pro [[i{{dfif ) I'| & &{y[FE=0 -
() I S AP -

(e 1) B ASIBIFREIES - ¥, B FTRGRS » S22 File >
Open Example ... F‘} Help > Open Example... -

N /
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it $ S  PTS USB § SRR - Agtlent 10

SEESES

Libraries Suite 15.0 “':&éﬁéné R
YN EG2E] USB B - [l GPIB RRERFVFF AR R 3 EIKI -

4

Al

Ly gk

(S

FEEVEE -

N ”?}Eﬁ%é'fﬁ |1 Agilent VEE Pro - Agilent VEE Express  %i

1B PC_FAOZ[E USB RIS A - I TR - S T
TF:‘ Ef5E (Found New Hardware Wizard) a:jﬁTﬁjirFsL rFA i o -
*WWﬂL*ﬁGF%THo

2 i Assign USB device alias a:jLEH“HfrJ. -HEE EJJ? M- N 0K }{ﬁ’ Ef
,erTﬁ

Assign USB device alias f@

Alias name: | UsbDevice2

Identification: | Agilent Technologies 344104 Digital Multimeter

Wisa Resource Mame:

Preferred | UshDevicez
Alternate | USED: 239115435 MY45001050:: 00 INSTR,
SICL Address String:
Preferred | UsbDevice2
Alternate | usb0[2391::1543::MY45001050::0]
Show this dialog

% Each time a USE device is plugged in.
" wWhen a new USE device is plugged in.

" Mever show this dialog
Ok | Cancel

N\ J
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3 ’E] ¥ Agilent VEE Pro F% Agilent VEE Express ( ¥ [JI]SF?%E*J)@%'* -

T [_, ] 40
7 2%IFpY Instrument Manager % s

4 Instrument Manager EUEFJE,T}{% %*ME? o 3= "~ Find Instruments %

V2
N

v EE& i B e
| |Firu:| Instrurnents I{Ctrl+Fj|
PYEVESEREI e g 2] (S PC VRS « YN Identlfy Instrument pop-up

SF B - 1 Yes o SIS USB 1 FORE < A1)
Hl » it Agilent 34410A Dlgrlt Multimeter °

Identify Instrument

Send "*IDMN?" to newlnstrument  { @USB0:2391:1543:MY45001050:0:INSTR)'?

The response to "*IDN?" provides an
@ accurate identification of this instrurment.

Mote: Older, non 488.2 campliant instruments do not

understand this command. Ifthis command causes an
errar in the instrument, cycle the power on the

instrument to reset it.
| o

5 7t Instrument List [“#5[[IfiY newInstrument F}%iﬁ?&ﬂ% BN AR
F'EJTFF”HFLWH %Hlp}%’ Create Direct 1/0 0b|ect » H F”rf"g
newinstrument iV Direct I/O P»{fihte T [®l b o PPt pr m\}{j ik J
MR = By o (E B B 0o )

/
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-4 USED

@ niewlnstrument]ag3441 a@l :hD e

Create Direct I/O Object

E Add Instruments ...

Configure Drivers

Load Sample

@ Remave DEL
=)

Properties...

6 [y Direct I/O PI{FpvE 1 pA%|) > ﬁﬁj’ L ph¥EE = Direct I/O P4 -

7 ;{ﬁ* IDN?" ( é,J—’%F}[EﬂF) g]?“ Y Fr- Y I/0 Transaction ‘ﬁj‘:’ﬂhfﬂ [1o
Jn F'J SCPI E ?ﬁ' lil }gg&ﬁﬁﬁ? i _“El—l o (2T Al I EFJ%:F;IP IHW
p , V| ﬁ? ﬁﬁgﬁ o 0,K & o
*IDN? i@ aedméSJ/%&ﬁJlH FIVIT AR [ BRR (SCPD) 1y i flathse

—|newlnstrument (an3d410a @UshDevice2) | F

= Double-Click to Add Transaction = |

W

/0 Transaction

:
| wrRITE ~| | TEXT =] [P*DN?

[ DEFAULTFORMAT  ~¥| EOLON

ok | mnop | cancel|

8 Jrf ™IDN?' i {3 B ) [ ey H Ve S e b newlnstrument
c;ﬁ,fp uru ﬂjfﬁu JFHTL b [Pﬁuﬂ?w B4 [ STRING FORAT < 3" READ
]J L I/I'HJ—J ° F“ru% K OK Eﬁ ﬁt Irfflj—j XFA i{/ﬁj °

. J
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|newlnstrument (an3d410a @UshDevice2)
WRITE TEXT "*IDN?" EOL

= Double-Click to Add Transaction =
YO Transaction

|READJ | BT | K
DEFAULT NUM CHARS

ok | mnop | cancel|

9 TV Display > AlphaNumeric > T“}H AlphaNumeric P2{FHo ~ [ -
Direct I/0 #4{F ELJ‘F[ 3o

Display | Tools Database E;
|[:j AlphaMumeric [\

r‘“
[=5 Logging Alphahurneric

Indicator »

10 [23F T }-{‘j’ Direct I/0 {31} £ AlphaNumeric $7{F - F537 E&WFV
# Direct I/0 ﬁi;l [i‘.H 2y~ IFL*WWH%"! }lf%l‘l o ;j g

FUiEfE= AlphaNumeric $(F Uﬁ?“ Jf‘uﬁ o *E"?F LS i’?hg_ﬁf

—|newinstrument (ag34410a @UshDevice2) | «|

WRITE TEXT "*IDN?" EOL
READ TEXT x 8TR
= Double-Click to Add Transaction = ﬂ

g b S Run S e | B

- /
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12 AlphaNumeric ${% €7 f}%%ﬁ%ﬁﬁ%@ﬁj[ﬁ"ﬂﬁﬁﬂi RUNRN N

— | newinstrument (ag344-1 0a @UshDevice2) | «| _
WRITE TEXT "IDN?' EOL = IITERITETE =]
READ TEXT % STR ¥ I— 1 Agilent Technologies, 344104 MY45001050,2.03-2.03-0.03-43-6

= Double-Click to Add Transaction =

13 %) ol [ (219 VEE A > G50 File > Save As > SR{AIL ) £
% Tutorial 1.vee o

N\
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s 2 ey
et A NHE S
A FEFE fiﬁfj'ff (R IR & R 1 T%T%'%%g °
1 (&Y Agilent VEE Pro B Agilent VEE Express = [=h[[ 12|72

U SR T File > New R » 3 5V Device > Virtual Source > Function

Geneiator ) ii}{ﬁfy@ﬁa;ﬁ Rl s S A=

evice | System /O Data Display  Tools Database  Excel  Wind

Formula l-? \[ﬂ_]] &I D'_'u ]-B'-{ - .\.a
MATLAE Script
Function & Object Browser Chrl+H !
UserObject

ThreadOhject

g

UserFunction
Call
Import Library

Rl (el ElEE & M

Delete Library

Sequencer

Wirtual Source

-

Function Generator

Regression IE‘ Pulse Generator

-ﬁ-lr Counker ﬁ‘ Moise Generatar

2 USSR [ BT 200 Ha POSRA L ORI ¢ s

41/4 °

—| Function Generator =]

Functon | Cosne v|
Frequency | 200

Amplitude [ 1
Deoffset | 0 | Func|
Phase [Deg=][ 0

Time Span 20m

Mum Points 255

/
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3 Y Display > XY Trace - *F XY Trace P{hbit il &+ Hif ‘Ljf 53

Display | Tools Database E:

) Alphahumeric

[=5  Logging AlphaMumeric
Indicator 4

{wy  BY Trace

e Strip Chart

Complex Plane

4 ﬂﬁﬁlér@ia‘ el g = XY Trace iU QL‘ S o f?&ﬁﬁﬂfffjﬁ
PR £ A lﬁr“‘ﬁ/ﬁ'ﬂ }-{‘“ﬂ" I oﬁwgé " S G FUEL
' E: XY Trace ;”Jﬁfﬂlﬁ? o F @391 f;n; eS| igﬁ,ﬁg

= XY Trace =

= Function Generator = Y name

Function | Cosine =]

Freguency 200

Amplitude [ 1

DcOffset 0 Func —81

Phase Deg =] o [Tzt
Time Span 20m
Mum Points 255 0

4 [

o 0.2 0.4 0.6 0.8 1

X name

5 - 7 E'Y Y Run B J [P E AR XY Trace Poff
ORI -

N\ J
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6 =XV Display > Spectrum (Freq) > Magnitude Spectrum - j%'ﬁ’ Magnitude
Spectrum P/{F v XY Trace Po{F  HpuT (B o

Device  System  LI/O  Data | Display | Tools Database Excel Window Help

Lo CE b | aehanmenc ,@nwm DML Bxa03

; [=5  Logging AlphaMumeric
Indicator

{w¢ mY Trace

iy atrip Chart

Complex Plane

faly Hws Y Plot

{4 Polar Plat -
Yy waveform (Time) . Y T | 4 |
- | Spectrum (Freq) L4 | L. Magnitude Spectrum L\@J
— Function Genera Ficture Phase Spectrum
Function Cosine Label Magnitude vs Phase (Polar)

Magnitude vs Phase (Smith)

Freguency 20 Beep
Amplitude 1 ke Pad
Droffset 0 Func —

Phase Deg «|[ 0 Trace1 03
Time Span 20m 100m
Murm Points 755 o

Hname

7 = 4 HCATHIP PR = ST R 3k o (Rl & d e
HIFE DT [ Magnltude Spectrum 4% Hﬁ?" o

\_

8 - " Run #F&: ﬂ 2RI mgﬁ Py 200 Hz G
gk o PRFRE pjaﬂ@df V&Hid;?} Kb 20& Hz p=fizse -

/
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=] Function Generator =]
Function M
Frequency
Amplitude
DcOffset Igamp Fune |
Phase -Ramp
Time Span | 22001
Mum Points 255

N\

= 0.3

—| Function Generator = Y name i,
Function | Cosine =] ot
Frequency | 200 02
Amplitude [ 1 0
-0.2
DcOffset lf Func —y1 v
PIEEE Deg ~|| © Tracet | °
Time Span >0m o

Num Points 556 o < y |>|

) 0 4m  8m  12m  16m 20m

X name
= Magnitude Spectrum =]
140
Mag 420
100
a0
60
1

Tracet *°

4 [

2000 4000 60007000

Freq

O SH T S OB SR P -
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10 £~ Run £¢ ﬂ FoHHEs s Bl Agilent VEE i ff [gg[ﬁjg?t]f %5 %I%
CIENTIEE e/ BTG i

= XY Trace =
1
- 0.8
= Function Generator & | Yname oe
Function Square h 0.4
Frequency 200 0.2
Amplitude 1 o
-0.2
DcOffset 0 Func [i—1 o
Phase Deg = 0 Trace1 e
Time Span 20m 0.8
Num Points 256 - p bl
= 0 4m  8m  12m  16m 20m
X name
= Magnitude Spectrum =
180
Mag 180
140
120
100
a0
— 60
Trace1

| [

o 2000 4000 60007000

Freq

1 ¥ ol e (19 VEE A GET0 File > Save As » 2HICE f £
£y Tutorial 2.vee o

- /
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Agilent VEE Pro == Agilent VEE Express [/ f{i|{V= £

N AEHS. Agilent VEE Pro = Agilent VEE Express 1/ [ti]fiuz 1 o

P

:‘jjﬁ: Agilent VEE Pro Agilent VEE
Express
i GPIB - LAN - v X
RS-232 ~ VXI ~
XI ~ SCXI
USB +
v ( EMGE: LiveMode
fiv Agilent USB £Eft
)
MatlabScript #7{$< MatlabScript 3 [# v X
H - Agilent VEE #45V[1Y RunTime 454 v X
#1 Agilent VEE i 254
B O R X
Callable Server ﬁl He o Fgp }{ﬁ’ Agilent x
VEE FJ [ = ActiveX Automatlon | 1R i
P L
Remote Function Thp o B e 7iﬁ£ o x
= fﬁ&rﬂ% pi- {i# Agilent VEE A H-p[ 1%k
WFU UserFunction °
v v

FRI:I;'g (h';fﬁl Fl °

N\

Agilent };ﬁiﬁl‘ " Agilent VEE Student #! Agilent Education 457%
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\
Agilent VEE 9.0 ;ll‘??rjjﬁt

ZENTSE - LF%ﬁJﬁ:p’jfE ll;Agilent VEE ot Vgl o iR [IPrpps > [
' 1} Agilent VEE A= [l o % [t =5 > IL;WE&pH%ww FFEM%
FIJ[HI’%@W" | bﬁlﬁ liloﬁi?J FSEl o FriiY Execution Mode “J [ " ¥~ 5H
Thpe HHEL

1Y SFHFREL - PP R 80T A ST ) W%'L F”F%
TS eAe CPU [T TS T I ﬁﬂmfpfﬁhpﬁl\_”chW %
%Eﬁmﬁ‘é Eabe I EUTT °

SCPI %55 - [ ™| [F%ﬂJﬁ‘. N p I S T BT SCPI A T FJ [&7 10
Transaction %”J]fFHlﬁi? SCPITJ ﬂjf :f/r:? FI‘EI%'A“EH 0 Ffrij Pi|:| EJEJTF*[L
»Jf%gh o U [ 30 p @4\% N&an ,ifgaa, SCP|—A’.|1J7;/1~E‘% 15 [1 ﬁ%ﬁfﬁj[ﬁ]
il e =t L{E*H i g P SCP fif > [y T =4 fplr ™ erE Py
[i3i SCPT i 474 -

Private UserFunction -- Agilent VEE 9.0 jlﬁ! - fzr%"rﬁlﬂﬁl “J UserFunction -- Private
UserFunction » 1’52 M._, R %‘,i‘j [ VEE A=V 5L VEE A=Y > I ™ |
SN R

f'gl'*?“fﬂ' TR - F=CF ﬁ’ﬂ?ﬁ f AR EZHI’”“\F AL g 2
§§7§ %&ﬁ#%ﬁ gﬁLpl%ﬁ.%ﬂﬂﬁ%%ﬁ SEE(P
'J NEIE'S

Breakpomtsfﬂﬁ[ - Breakpoints i) A i 3 (SR 42 ]| VEE %ﬂf[lg YETE [l
%!‘ 719> (&5 )7 Breakpoints i Fi,] IIEW' IR B gﬁ?’!‘ RS2 [[ng’g‘

Error Call Stack -- ({1 *'| Error Call Stack i’ {2 '11[?”%%4 iy VEE M= = Error Call Stack
fﬂa—u I ﬁﬁ,ﬂﬂl UserObject F% UserFunction =9} - Error Call Stack ”J%"ﬂgl—T
[HHTEY g > UserObject

,/
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4 )

7% UserFunction L7 £ p[1ALIR TS P2 PLIAE & SRS E VR G Lot -

WA RVRI Y 48 - J S = ADONET 7 Ffrébjﬁﬁlr = v

’El » 911 Microsoft Access ~ Microsoft SQL Server ~ Oracle ~ MySQL 7% &7 f
R A BT e YR %naﬁiﬁﬂjﬁj%ﬁ'
%’Jvzf EH“L_I* 7] TEPK/?EH

LXI 338 - 7% LXI ,;m!«gfr; €] Web /7 [+ 5 /7 PR REAS BRER PV E Y
A LAN i EIF' URgHE S T Jbﬂ Wﬁfu Agllent VEE #i# — [ BFfo ik
%L 7 VEE [* GEEH BT H B Y LXI Web f1 o1 -

iéﬁ?}[élﬂ Default Preferences -- Default Preferences %} ’LFJQHIH;I s e ey
S | ERLI LS (S R i B

EF‘F”E 'zmpﬁ"%_‘j'%: -[ETYAFESG Agllent VEE 9.0 &< 5 XMLTE
?‘ ﬁE T PHeRT “JK?AgllentVE 90 & B o R (O 1 T
;[H 'ﬁﬁ’ XL S XML - A

VEE Obect (997 313) - - At ) Saien Sl R
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